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CONSOLE is a software that enables you to adjust the settings of a camcorder from

a computer and to record on the tape in the camcorder and onto the computer’s

hard disk by connecting the camcorder using an IEEE1394 (DV) cable. You can Troubleshooting Shortcut Keys
adjust and save the Custom Preset settings of the camcorder and analyze a

shooting image using a waveform monitor and a vector scope to compose the

image you want.

This software is for use with Windows® XP (Service Pack 2) only. English
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Read This First

B Disclaimer

o While every effort has been made to ensure that the information contained in this guide is accurate
and complete, no liability can be accepted for any errors or omissions. Canon reserves the right to
change the specifications of the hardware and software described herein at any time without prior
notice.

O No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval system, or
translated into any other language in any form, by any means, without the prior written permission
of Canon.

o Canon makes no warranties for damages resulting from corrupted or lost data due to mistaken
operation or malfunction of the camcorder, the software, personal computer, or peripheral devices.

B Trademark Acknowledgements

o Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft Corporation
in the United States and/or other countries.

o Other names and products not mentioned above may be registered trademarks or trademarks of
their respective companies.

o Avid® and Avid Xpress® are either registered trademarks or trademarks of Avid Technology
Incorporated.

© Canon Inc. 2006 All rights reserved.

Canon camcorder compatible with CONSOLE

Following camcorder can be used with CONSOLE.
XH G1 \ XH A1 |

*Unable to use some functions

XL H1* ] XL2* \

Required Accessories

o Canon digital camcorder compatible with CONSOLE
0o |IEEE1394 (DV) Cable
Check the manual of your computer for which type of cable to use:

4-pin: T — 6-pin: 4.5

System Requirements

(O] Microsoft Windows XP Home Edition or Professional®
(Installation of Service Pack 2 required)
Proper operation is not guaranteed on Windows XP that has been upgraded
from a previous version.

CPU * Pentium M 1.5GHz or better

* Pentium 4 2GHz or better (Pentium 4 3.2GHz or better recommended)
RAM 512 MB or more (1 GB or more recommended)
Hard Disk For installation: 100MB or more of free space required

For video recording: 1GB or more of free space required
File System: NTFS

Display 1024 x 768 or more required, Full Color (32bit) required
Sound Windows XP compatible sound system
Interface IEEE1394 (OHCI compliant)

*The software cannot be operated on Windows XP Professional x64 Edition.

O Proper operation is not guaranteed on all of the systems that meet the requirements
@ outlined above.

O Recordings cannot be made on FAT32 or FAT16 formatted hard disks.

O If you set the video folder to an external hard disk, an error message “Delayed Write Failed”
may be displayed while recording onto the hard disk, and the recording may be lost.

O Recordings cannot be saved on a hard disk recognized as [Removable Disk].

o If you connect 4 or more devices (including the connected computer and the XL H1 itself) by
IEEE1394, CONSOLE will not run properly.

- Proper operation cannot be guaranteed if you are using a repeater.

O If your computer has an IEEE1394 (DV) board/card in addition to the standard IEEE1394
(DV) board/card, or if you have several IEEE1394 (DV) boards/cards added to the
computer, the computer may not recognize the camcorder properly. In such case, see
Camcorder will not be recognized or controlled. ([1] Appx-59)

O This software will not operate properly if more than one camcorder is connected to the
computer.

o Depending on the setting of the power scheme of the laptop PC, the preview images may
not be played back smoothly. Select [Always On] in the [Power Options Properties] window.
([ Appx-60)

o When the computer enters stand-by mode or hangs up while running CONSOLE, proper
operation is not guaranteed after recovering.

O When dealing with HDV recordings, regardless of the operations, the CPU usage may go up
to the maximum. If the usage continuously goes over the 100% for a long time, data
dropping from a file may occur, or the computer may become unstable. In such case, see
The recorded picture is lacking. (1] Appx-60) and change the software settings to reduce
the usage.

O To edit a file recorded in HDV, use editing software that supports the HDV standard.

O This software can also be used with the recordings in 24F (NTSC only). Use an editing
software that supports the 24F frame rate.



Read This First

What is CONSOLE?

CONSOLE is a software that enables you to adjust the settings of a camcorder from a computer and

to record on the tape in the camcorder and onto the computer’s hard disk by connecting the

camcorder using an IEEE1394 (DV) cable. You can adjust and save the Custom Preset settings of the

camcorder and analyze a shooting image using a waveform monitor and a vector scope to compose

the image you want.

With CONSOLE you will be able to:

» Record the camcorder image onto the computer’s hard disk.

» Output the image recorded on the hard disk to a monitor via the camcorder.

* Adjust the camcorder’s settings (Custom Preset) and export them to the computer’s hard disk and
the camcorder.

» Analyze the image using a waveform monitor and a vector scope.

» Compare the camcorder image and the recorded image by simultaneously displaying both images in
the same window.

* Display a safety zone marker, an aspect marker and several other markers on the window and
create new markers.

* Perform the cache and frame recording.

B Differences from CONSOLE 1.0

» Supports XH G1 and XH A1

* New plug in: Color Correction, Skin Detail and Sky Detail

* Allowed to save the Custom Preset file to the camcorder when it is set to the Camera mode

» Customizing function of the shortcut keys

« Calling the registered workspace using shortcut keys

» Changing the shortcut keys for displaying/hiding the [Rec Viewer] window and the [Camera Control]
window

B Limitations During the Trial Period

During the trial period, you can start CONSOLE 50 times limited to within 14 days. During the trial
period, the following limitations apply to CONSOLE.

* You can operate CONSOLE for 120 minutes only.

* You can record for 5 minutes only.

* You cannot export or load Custom Preset files.

B Functional Comparison

The functions available differ depending on the connected camcorder and the camcorder mode.

+ EXT.CONT. mode (£ ): This mode is available for remotely controlling the camcorder. When the
camcorder is set to EXT.CONT. mode, only the following functions of the camcorder can be used.
- Camcorder’s start/stop button
- Handle and grip zoom lever
- ZOOM SPEED switch and dial
- EJECT switch
- All audio related adjustments except for AUDIO MONITOR button

+ Cameramode ((A] Tv Av M & []): This mode is available for directly controlling the
camcorder.
- Some functions of CONSOLE cannot be used.

« VCR/PLAY mode (& ): This mode is available to playback or output the picture recorded on the
tape.
- You do not use this mode when you connect the camcorder to the computer.

Camcorder XH G1/XH A1 XL H1 XL2
Mode CEOXI\-IFT Camera CEOXI\-er Camera CEOXNTT Camera

Custom Preset Settings o) o o o) Q x
Exporting the Custom Preset to the camcorder o o o o) Q x
Exporting the Custom Preset to the memory o x o x " x
card

Exporting the Custom Preset to the computer’s

hard disk ° ° ° ° °© °
Color Controlling o o) x x x x
Camera Control tab o) x o x o x
Image output o) x o) x 0] x
Copying files from the memory card o x o x x x
HDV recording o o o o x x
DV recording o o o o o o
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Preparation (Installation, Connection, Launch, Activation)

Installing the Software and Drivers
Follow the procedure below to install CONSOLE, Canon Virtual VCR driver and AV/C Camera

Storage Subunit-WIA driver.

Installing CONSOLE and the Canon Virtual VCR Driver

®

0 Do not connect the camcorder to the computer when installing the software.
O You need to log in as an administrator before installing the software.

O Close all programs that are running before installing the software.

Canon Utilities CONSOLE 1.1

Canon Utilities CONSOLE 1.1

| Mest>

The Install? hield® Wizard will install Canon Utiities
CONSOLE 1.1 onyour computer. To continue, click Next.

D el |

Start the CONSOLE installer and
click [Next].

2 Read the license agreement and click [Yes] to accept the terms and to
start installation.

3 Canon Utilities CONSOLE 1.1

Choose Destination Location

Select folder where Setup wil install files.
Setup willinstall Canon Utiities CONSOLE 1.7 in the following folder.

another folder.

Destination Folder

C:AProgram Files\Canon

To install to this folder, click Next. Ta install to a difterent folder, click Browss and select

<Back (| Mest>

Browise

D el |

Confirm the target folder and

click [Next].

« If a dialog appears asking you whether you
wish to create a shortcut for CONSOLE,
click [Yes].

« If a warning window concerning the
installation is displayed, click [Continue
Anyway]. The dedicated driver will be
installed automatically.

4

Canon Utilities CONSOLE 1.1
InstallShield Wizard Complete

Click Finish ta launch CONSOLE

\when application is launched fist time, 2 virtual device of
“Canon Yitual VCR" or "BY/C Tape Recorder/Player” will be
detected and "Found New Hardwars \wizard” will appear. The
virtusl device is necessaty for CONSOLE to work. Pleass
select "Install the software: automaticall (Recommended]” and
install & civer for the device

Found New Hardware Wizand

Welcome to the Found New
Hardware Wizard

“windows will search for curtent and updated softwars by

lacking on your computer. on the hardwars instalation CD. or on
the Windavs Lipdate Wweb site (with your permissian),

Read our privacy policy

Can Windows connect to Windows Update ta search for
software?

© Yes, this time only
() ¥er o znd every time | cannect a device
(3) o, ruok this time:

Click MNext to continue.

Found New Hardware Wizard

This wizard helps you install software for:

Canon Vittual WCR

() 1f your hardware came with an installation CD
or floppy disk, insert it now.

(%) Instal the software automatically [Recommended)

) Tetamr——

=]

Click Next to continue,

<Back ([ Mews ) Cancel

Click [Finish].

Select [No, not this time] and
click [Next].

Select [Install the software
automatically (Recommended)]
and click [Next].

If a warning message regarding the
installation appears, click [Continue

Anywayl].



Preparation (Installation, Connection, Launch, Activation)

Found New Hardware Wizard CIiCK [FiniSh]-

Completing the Found New
Hardware Wizard

The wizard has finished instaling the software for

J Canon Wittual VCR

Click Firish to close the wizard,

Installing the AV/C Camera Storage Subunit-WIA Driver

The AV/C Camera Storage Subunit-WIA driver is used for downloading and uploading the Custom
Preset file (Camcorder settings) from and to the camcorder. When installing the AV/C Camera
Storage Subunit-WIA driver, you need to connect the camcorder to the computer. Refer to Connecting
the Camcorder to the Computer ([111-8).

O Without Installing the AV/C Camera Storage Subunit-WIA driver, you cannot adjust the
@ Custom Preset settings.
O This driver will be installed every time you connect a camcorder for the first time. From the
second time you connect the camcorder, the driver will not be installed.
O You need to log in as an administrator before installing the software.
O Close all programs that are running before installing CONSOLE.
0 Do not turn the camcorder’s power off and do not quit the driver’s installation before
completing the installation of the driver.

1 Turn the camcorder’s power on and activate the DV CONTROL
function.

2 Set the camcorder’s recording program to EXT.CONT.

3 Connect the camcorder to the computer using the IEEE1394 (DV)
cable. ((111-8)

* For details about connecting the camcorder to the computer, refer to Connecting the
Camcorder to the Computer ([111-8).

* When the [Found New Hardware Wizard] window appears, select [No, not this time] and
click [Next]. In the next window, select [Install the software automatically (Recommended)]
and click [Next].

- If a warning message regarding the installation appears, click [Continue Anyway].

* Installation of the driver starts automatically.

» Depending on the setting of the computer, an editing software may be launched. If this
happens, close the software.

+ After completing the installation, [Scanner and Camera Wizard] or a window asking you to
choose the software may be displayed. Click [Cancel] and close the window.

4

mzr) Check if the driver has been
| installed correctly.

Open [My Computer] and check if the [Canon Camera Storage Device] icon appears. If the
icon does not appear, the installation has not been completed properly. Uninstall (11 7-54)
and reinstall the driver.
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Connecting the Camcorder

Connecting the Camcorder to the Computer

Turn the camcorder’s power on and activate the DV CONTROL
function.

Set the camcorder’s recording program to EXT.CONT. or Camera

mode.
* When the camcorder is set to EXT.CONT. mode, only the following functions of the
camcorder can be used.
- Camcorder’s start/stop button
- Handle and grip zoom lever
- ZOOM SPEED switch and dial
- EJECT switch
- All audio related adjustments except for AUDIO MONITOR button

Connect the camcorder to the computer using the IEEE1394 (DV)

cable.

* You do not need to turn off the computer.
* Do not deactivate the DV CONTROL function while the camcorder is connected to the

computer.
* Refer to the computer manual for the location of the computer’s IEEE1394 (DV) port.

=0 |

DV cable

HDV/DV terminal —'@‘. ) k(== [~ IEEE1394 port

&
on the camcorder

on the computer

;’ Preparation (Installation, Connection, Launch, Activation)

* Follow the procedure below to confirm if the camcorder is properly connected. Your
camcorder is correctly connected if you see items described in step 4 in the [Device
Manager] window.

1) Set the camcorder to EXT.CONT. and connect to the computer.
2) Open the [Device Manager] window. ([I17-56)
3) Select [Devices by connection] from the [View] menu.
4) Confirm that the following names are shown under IEEE1394 controller.
» When connecting to a computer in HD mode:
[AVIC Tape Device], [Canon Camera Storage Device] and [Canon Virtual VCR] are
shown.
* When connecting to a computer in SD mode:
[Canon DV camcorder], [Canon Camera Storage Device] and [Canon Virtual VCR] are

shown.
£, pevice Manager E@E}
File  Action  Wiew Help
& 2 8
=1 ConsOLE -~

=] -j ACPI Uniprocessar PC
= 4 Microsoft ACPT-Campliant System
% InteliR) Pentium(R) 4 processor
% Matherboard resources
=¥ PClbus
= ¥ Intel(R) 92001 PCI Bridgs - 2448
=g OHCI Compliant IEEE 1394 Host Controller

B 1504 Mk Adanrer
@, avC Tape Device
=4 Canon Camera Storage Device
38 Canon Yirkual YoR v
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Launching CONSOLE

Changing the Software Event Setting

When using CONSOLE, you need to deactivate the Windows program that automatically prompts you
to choose an application when you connect the camcorder to the computer (set to “Take no action”).

1 Set the camcorder’s recording program to EXT.CONT. or Camera

mode. ([111-8)

2

T G e o Dbt
3 | Dsexr

setdoss | 9wy Computer

Faders | [~

Fies Stored on This Computer

Canon Camera Storage Device #2 Properties

General | Events | Color Management

Select an gvent a e

Aitions

O Start this program: =8

() Take no action

() Save all pictures to this folder

ewenl ocours,

—

Choogs an event below, then select the action to take when that

Right-click on [Canon Camera
Storage Device] icon in the [My
Computer] window and choose
[Properties].

Select [Device Connected] at
[Select an event] and select
[Take no action] under [Actions]
in the [Events] tab and click [OK].

Starting the Application

@

O You need to log in as an administrator before installing the software.

o Do not change the user account while running CONSOLE.

o If you are running software that displays the time at the title bar, the title bar may not display
texts properly.

O Do not change the settings in Windows [Display Properties] window while launching
CONSOLE.

Double-click the [CONSOLE 1.1] icon on the desktop.

* When you have not registered the license yet, the remaining trial period and number of
times you can start CONSOLE are displayed. Click on [Register] when you proceed to
register the license. ([11 1-10)

* When the trial period is expired, or the number of times you can start the CONSOLE is
exceeded its limit, a warning window appears. Click on [Register] and proceed to register
the license. ([11 1-10)

Confirm the target folder (video folder) and click [OK].

Confirm Video Folder

By removing this checkmark, this
window will not appear next time
you start CONSOLE.

Click [Modify folder] to change
the target folder.

The first time you start CONSOLE, the target folder is set as [Windows drive:\Documents and
Settings\login user name\My Documents\CONSOLE\date\]. If Windows is not installed on an
NTFS formatted hard disk, the following dialog appears. Click [Specify] and select a folder on
an NTFS formatted hard disk.

Video Folder setting

If you set the video folder to an external hard disk, an error message “Delayed Write
Failed” may be displayed while recording onto the hard disk, and the recording may
be lost.
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Activation

You can use all of the functions of this software after registering the license key. During the trial
period, you can start CONSOLE 50 times limited to within 14 days.
During the trial period, the following limitations apply to CONSOLE.

- You can operate CONSOLE for 120 minutes only.

- You can record for 5 minutes only.

- You cannot export or load Custom Preset files.

Purchasing the License Key
* For details about purchasing and receiving the license key, please visit the Canon’s download site.
* You can use the same license key you have already purchased for CONSOLE 1.0 if you are
installing CONSOLE 1.1 to a computer in which CONSOLE has not been installed previously.
* You do not need to register the license key again if you are installing CONSOLE 1.1 to a computer in
which CONSOLE 1.0 had already been run. The license key information will be carried on
automatically.

1 Setthe camcorder’s recording program to EXT.CONT. or Camera mode
and connect the camcorder to the computer. ([(1]11-8)

2 Start CONSOLE.

3 Click [Register] in the trial
confirmation window.

If you are already running the software,
select [Version] » [About CONSOLE] and
click the [Register] button.

4 Confirm and note the product ID.
If an appropriate camcorder is not connected to the computer, the product ID will not be
displayed.

License Registration

Product ID

9 Visit the Canon’s download site where you downloaded the trial
version software and follow the instructions on the site to purchase
the license key.

You will need the product ID obtained in the step above to purchase the license key.

6 Receive the license key.

Registering the License Key

1 Ssetthe camcorder’s recording program to EXT.CONT. or Camera mode
and connect the camcorder to the computer. (1] 1-8)
Connect the same camcorder as the one used for receiving the license key.

2 Start CONSOLE.



Preparation (Installation, Connection, Launch, Activation)

Click [Register] in the trial
confirmation window.

If you are already running the software,
select [Version] » [About CONSOLE] and
click the [Register] button.

Check the product ID.

If the product ID is not the same as the one for receiving the license key, you cannot register
the license.

License Registration

Product ID

9 click [Register] after entering the license key and a user name.

License Reeistration

\l,r) Licenze information iz regiztered.

[CONSOLE &

License Key

1 Click [OK].
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CONSOLE Windows
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CONSOLE Windows | Various Settings and [Performance Check] =~ Camera and Picture Control Recording onto the Hard Disk = Playback the Recorded Files m

CONSOLE Windows

—

Menu Bar

Main Panel m [File] Menu

1 File(F)
Ciptionin, ..
5 e —— : sec Shortout Sektings(S) —— 2
FE #*6 Bae+E8 DB
Exit(x) 3

1 Displays the [Option Settings] window ([113-17).
2 Changes the default shortcut key settings ([T1Appx-61).
3 Closes CONSOLE.

H [View] Menu

, v Main Toolbar (M)
Toolbars(T) p—» |« Rec Toolbar(R) 1
v Play ToolbariP)

Rec PanellR) I\

Play Panel(F) 3 W Main Windowik) Ctrl+R.
\Work Spacel’h) b v Rec Yiewer(D) ZhrH-M
v _amera ControlCh ChrlH+5 5
v iZolor Control{ion) ChrHO
v Focus fssisk(Fl CkrHF
v Weckor and Wave Monitor(y)  Cerl4+H
4 3 w Custom Preset(l) Chrl4+I
1 Menu For details, refer to Menu Bar ([112-13). v Main Windaw) Chrl+P
[Play Panel] Displays [Play Viewer] ([116-50), [File Browser] ([116-52) and a .
Waveform Vector Monitor ([114-32). w Flay Viewer(D) ChriH+D —3
3 Camcorder Information Shows the camcorder model name and the status of the tape in the v File Browser(E) Chri+E
camcorder. For details, refer to Camcorder Status ([112-14). v Weckor and \Wave Manikor(s el
4 Software Status Displays the status of the software.
5 [Rec Panel] Displays [Rec Viewer] ([114-23), [Focus Assist] ((114-28), [Camera Add Wark Space(a)...
Control] ((114-28), a Waveform Vector Monitor ([114-32) and Delete Work Space(D)...
[Custom Preset] ([114-37). 1. Standard 4
6 Toolbar For details, refer to Toolbar ([112-14). 2. Wark Space A
@ Select [Exit] from the [File] menu to end the application. 3. Wark :Space E

Displays/Hides the toolbar ([112-14).
Displays/Hides [Rec Panel] and the recording tools.
Displays/Hides [Play Panel] and the playback tools.
Adds/Deletes the work space ([112-15).

A WODN =
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CONSOLE Windows
—

B [Version] Menu

Mersion(T)

About COMSOLE(A),,, ——— 1

1 Displays the version and the license information.

Camcorder Status
This status shows the name of the camcorder connected and status of the tape.

Icon Status of the tape
No tape in the camcorder

Stop mode
Recording
Tape reached the end

Tape is write-protected.

l 0 (6 0 61 (B

Tape error

Toolbar

There are “Main Toolbar”, “Recording Toolbar” and “Playback Toolbar” in the main panel. Each toolbar
can be displayed or hidden, or moved around (docking and floating) with the mouse.

» Docking * Floating
Main
CONSOLE E | El # e

FilefF)  Wiewiy) WYersion(I)

o/ CONSOLE

File{Ey  Wiewi) | Yersion(I)

Cantral

[®] Rec Panel

| WHITE BALANCE
Sy AWB

B

Camera Control Rec Viewer (22%)

Information .~ Contral

| WHITE BALANCE
L

o=y

B Main Toolbar

1 2 3 4
Displays/Hides [Rec Panel].
Displays/Hides [Play Panel].
Displays the [Option Settings] window ([113-17).
Displays the version information.

A WODN =

B Recording Toolbar
1 2 3 4 5 6

| ] | |
1ol 38 3L =]

Displays/Hides the [Rec Viewer] window.
Displays/Hides the [Camera Control] window.
Displays/Hides the [Color Control] window.
Displays/Hides the [Focus Assist] window.
Displays/Hides the waveform vector monitor.
Displays/Hides the [Custom Preset] window.

B Playback Toolbar

O b ODN =

1 2 3

-
B Q&

1 Displays/Hides the [Play Viewer] window.
2 Displays/Hides the [File Browser] window.
3 Displays/Hides the waveform vector monitor.

o,
' redisplay.

To redisplay the toolbar, select [View] » [Toolbars] and the name of the toolbar you want to
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CONSOLE Windows

Work Space

You can register your own panel layouts to suit the purposes of the projects.

1

Select [View] » [Work Space] »
[Add Work Space].

it COMSOLE - [Rec Panel]

Taalbars(T)

2+ EE BC
Rec Panel(R) 3
Play Panel(P) »

Add Work Spaceia)...

Delete Work SpaceiDy,..

1. Standard

2 Input the name of the work space
and click [OK].

The positions of the windows are registered,
and the name of the work space will be
displayed in the menu.

o Up to 10 workspace configurations can be registered. To delete a work space, select
[View] » [Work Space] » [Delete Work Space].

O To choose the registered work space, select [View] » [Work Space] and the name of the
registered work space. You can also press the [Ctrl] key and the number key (which
corresponds to the displayed work space number) simultaneously to switch the work space.

O
@

add Wark Spacelal...
Delete Work Space(D...

1.[5tandard
Z. [Work Space &
3, [Waork Space B

Camcorder Screen

The CONSOLE status and the remaining recording time on the hard disk are displayed on the
camcorder screen.

HDVBOi

00:53:56:27R
7 min
—]

] e |
MANUAL

1/60

F5. 6

DVZ,®77B6min

Icon CONSOLE Status
DY 2 Not started
DY 2| Stop mode
Dy 230 Recording
DY 2 Data dropping occurred ([115-48).

Cannot record ([JJAppx-59).

B2~ Check the setting of the video folder.

2y © If [[[%2>] is not displayed, activate the DV CONTROL function of the camcorder.

“Z4| o When XL2 is connected to the computer and other device is connected using IEEE1394, the
status of the camcorder and the remaining recording time will not be displayed on the
camcorder’s LCD screen.

O When the hard disk does not allow recording (e.g. hard disk space is running out), recording
is made only on the tape.
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[General] Tab
Video Folder and Recording Settings
Option Settings
You need to specify the video folder (a target folder), file name and other settings before you start the =
recording the camcorder pictures onto the hard disk. [ Geneal |
1 — Select [Option] from the [File]

i COMSOLE menu, or click #%.

YigiW)  Version(l) 1
— S
Shortcut SettingsiS) —
Exiti)
| Custom Preset 2
2 P Choose one of the tabs, set the 3
option settings and click [OK]. 4
5
6
7
Cancel
1 [Folder name] Shows the selected folder.
[Modify] Selects a different folder.
[Create sub-folder] Creates a subfolder within the folder shown under [Folder name]. You can
name the folder after the date by selecting [Use recording date] or specify
a new folder name under [Specify folder name].

2 Specify the file name of the video recording. A sequence number (up to 9999999) will be

allocated after the specified prefix (e.9.“CNSL0001.avi").

3 + Place a check mark to record the Custom Preset settings of the camcorder onto the hard
disk. CONSOLE only saves the settings of the camcorder when the recoding is started. The
name of the Custom Preset file will be the recording file name, and the extension is “.cpf”.

» When [Sequence] or [Frame] mode is selected in the [DV Rec] tab of the [Option Settings]
window, the Custom Preset file will be recorded only when you started the recording.

4 When the camcorder’s sound setting is set to 4ch, channel 3 and 4 sounds will be recorded

separately from the recording file. For example, when “DVPC0001.avi” is recorded,
“DVPCO0001_sub.wav” is recorded in video folder.

5 Sets the cache recording time ([115-46).

6 Placing a check mark displays a dialog confirming the video folder each time you start CONSOLE.

7 When the remaining battery power goes down below the specified level, the hard disk

recording will be automatically terminated.
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Various Settings and [Performance Check]

[DV Rec] Tab [HDV Rec] Tab
This tab is for the DV standard recording settings when you record in DV. This tab is for the HDV standard recording settings when you record in HDV.
Option Settings Option Settings
1 1
{ecording mode: O Stand
2
3
4
1 Select the recording file type. 1 Select the recording file type.
Select the AVI type that is compatible with your editing software. You can select the file type Select the AVI type that is compatible with your editing software. You can select the file type
from [AVI-Type1], [AVI-Type2] or [DV-MXF]. For details, refer to the instruction manual of the from [MPEG2TS] or [MPEG2ES]. For details, refer to the instruction manual of the software.
software or consult the software manufacturer. 2 Select the [Preview resolution] of the HDV standard data. The size of the recording picture will
2 Select a mode for recoding onto the hard disk. not be changed.
[Standard] A new file will be created each time you start recording a new scene. 3 Select the type of MPEG2 for the picture displayed in the preview. The types of the recording
[Sequence] The new scene will be added to the same file. picture will not be changed.
[Frame] 1 frame is recorded and added to the same file each time you press the recording 4 Select whether or not you need to convert the color of the preview image. When the color of
button. ([115-47) the preview image appears odd, select [OFF].
- Placing a check mark at [Interval recording] makes CONSOLE to repeatedly
record the frame image at the specified interval time. @ 0O When recording an [MPEG2ES] picture, WAV sound files with the same file name as the
) ® ] ] ] ) recording file will be saved. The sounds on channel 1 and 2 will be recorded in “File
@ O Avid Xpress™ can properly read 60i, 30F, 50i or 25F MSF files recorded by CONSOLE; it Name.WAV”. When the audio mode is set to 4CH, the sounds on channel 3 and 4 will be
cannot read 24F MXF files recorded by CONSOLE. recorded in “File Name_sub.WAV”. When using the editing software, load all the sound files.
O When recording an [DV-MXF] picture, WAV sound files with the same file name as the o The recorded [MPEG2ES] picture cannot be output to the camcorder.
reCOrding file will be saved. The sounds on channel 1 and 2 will be recorded in “File o When [A" pictures] or [l picture and P picture] is selected, data dropping (ED 5_48) may
Name.WAV”. When the audio mode is set to 4CH, the sounds on channel 3 and 4 will be oceur.
recorded in “File Name_sub.WAV”. When using the editing software, load all the sound files.




CONSOLE Windows | Various Settings and [Performance Check]

[Performance Check]

You can check whether the selected video folder can be used for saving the recordings before you

start recording on the hard disk.

1

Option Settings

Set the recording settings and
click [Performance Check].

When the [Performance Check] button is
not being activated, click the [Apply] button.

Camera and Picture Control = Recording onto the Hard Disk = Playback the Recorded Files m

2

Various Settings and [Performance Check]

Click [Start] on the left side.

The performance check of the hard disk starts.

* CONSOLE writes the data to the selected folder to evaluate the performance of the hard
disk and graphs out the results every second.

» The performance check takes approximately 30 seconds.

« To cancel the performance check, click [Stop].

Performance Check
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3 Click [Start] on the right side.

The performance check of the system starts.

* CONSOLE writes the data to the selected folder to evaluate the CPU usage ratio and
graphs out the results every second; furthermore, it evaluates the occurrences of the data
dropping and the frame rate of the preview.

» The performance check takes approximately 30 seconds.

« To cancel the performance check, click [Stop].

vy © When CONSOLE executes the performance check, the recording data type used for

& writing (DV or HDV) will be according to the recording settings in the [DV Rec] tab.

- When receiving the DV standard data from the camcorder while [Frame] is selected in
the [DV Rec] tab, the writing test of the performance check will not be executed.

The performance check cannot be executed when CONSOLE cannot access to the hard
disk.

4 Review the result and click [Closel].

Performance Check

2y ° Even if all bars are above the red line after executing the hard disk performance
" check or no data dropping has occurred during the system performance check,
data may be dropped when a program accessing the hard disk (e.g. anti-virus
software) is activated.
O A bar below the red line indicates that data may be dropped during recording (a part of
the picture may not be written to the file).
o When recording in HDV standard is selected and data dropping occurs, select a smaller
size at [Preview resolution] or [I picture only] at [Preview picture] in the [HDV Rec] tab.
([d1 3-18) The recording picture will not be affected even if you change the [Preview
resolution] or [Preview picture].
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Various Settings and [Performance Check]

4 o poe Enter the new key you wish to
change to in the [New Key] box

and click [Apply].

The new key setting will not be applied

unless you click [Apply].

Changing the Default Shortcut Key Settings

You can change the default shortcut key settings to convenient key settings.

1 o Select [Shortcut Settings] from
e COMSOLE the [File] menu.

FIEWEN Wiy Wersion(T)

Option{0)... El_ |E

2z Clicking [Set Original] initializes the shortcut key settings to the default parameters
“Z4 (M Appx-61).

5 Click [Close].

Click Ed of [Category] and select
the category to which the
shortcut key that you wish to
Current Key chan e belon S.

i g g

Apply

Mew Key:

ginal

Apply

inal

Select the target shortcut key
from the [Command] list.

Current Key:
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Using the Recording tool to adjust the picture settings of the camcorder to create a picture in the [Rec
Panel].

[Rec Viewer]

Rec Viewer (17%) |+ 1

0o001.+MPEG

e

i

=T
7 6 5
Displays the camcorder picture.

Right-clicking on the picture allows you to select the size of the
preview panel ([114-23) and display the overlay markers ([114-24).

Selects the audio channel displayed on the audio level indicator and
adjusts the monitor volume.

Turns ON/OFF the computer’s audio monitor output.

1 [Rec Viewer]

2 Audio Monitor
Settings
3 Audio Monitor

4 Audio Level Indicator  Displays the audio level output from the camcorder. The sound can be
monitored with the computer’s sound system.

5 Zebra Pattern Displays the zebra pattern ([114-27) in the preview.

6 Split Splits the preview ([114-27).

7 Color/Monochrome Switches the preview between color and monochrome display.

8 Interval Counter When [Interval recording] ([113-18) is selected, the remaining interval
time is displayed.

9 Time Code Shows the time code of the file.

10 Recording Indicator The indicator will turn while recording on the hard disk.

11 File Name Displays the file name of the recording file.

When the connected camcorder’s recording mode is set to HD mode, there will be a delay
between the image displayed on the camcorder’s display and the image displayed on the
computer screen.

Camera and Picture Control = Recording onto the Hard Disk = Playback the Recorded Files m

Adjusting the Preview Size

The size of the [Rec Viewer] window can be adjusted freely by dragging the edge of the frame with the
mouse. You can also change the size of the preview window with the size option in the right-click
menu.

When the preview is in [Full Screen] mode,

click the mouse to return to the previous
size.

Rec Viewer (17%)

Marker SettingsiM). ..

100%(D)
S0%(H)

Full ScreeniF)

O The [Rec Viewer] window will be resized according to the specified size or the [Rec Panel]
size. When [Rec Panel] cannot resize the [Rec Viewer] window according to the specified
size, it will be displayed according to the [Rec Panel] size.

O The preview size on the title bar is displayed as a percentage of the preview resolution.

- When previewing HDV data, the percentage will be based on 1920 x 1080 resolution.

@
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/ Camera and Picture Control

—
Overlaying Marker 1 Marker List - Placing a check mark displays the marker on the preview.
You can display the overlaying marker in the preview. The safety zone (90% and 80% of the preview * [+ or [=] that appears next to a marker name indicates that the marker is a
image size), a center, a level and 8 types of aspect markers are predefined as the default markers. group marker which contains several markers in it. Select one of the
markers in the group. Clicking [+ opens the group marker set and clicking
@ When splitting the preview image ([114-27), the markers are not displayed. [=I closes the displayed marker set, displaying only the group name.
* You can change the name and group that the marker belongs.
m Displaying Overlaying Markers and Settings 2 [Aspect ratio] Selects the aspect ratio of the marker preview.
3 [Marker preview] Displays the marker and allows you to edit it.
1 . . . 4 [Coordinates of T?king the upper left corner as a base.point, the coordinate gf the marker is
Rec Viewer (17%) Right click on the preview and selected marker] displayed as a percentage. You can directly enter the coordinates.
Ll select [Marker Settings] from the 5 [OK] Quits the marker setting, and displays the selected marker in the marker
menu. preview.
Select a marker and click [OK] to display the 6 [UpJ/[Down] Moves the marker name in the marker list.
marker. 7 [Export] Saves the marker.
8 [Import] Adds a new marker in the marker list.
9 [Add] Creates a new marker.
10 [Delete] Deletes a marker.
11 [Property] The property of the selected marker is displayed. You can change the group
name and the marker name.
1 2 3

Marker Settings ‘

9 | Lot ] — Fiepo | AR
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_/ Camera and Picture Control
B Adding a New Marker 4 Select the [Aspect ratio] and click [Add].

1 Click [Add].

[Marker Sattings

2 Select the marker group.

« If the new marker does not belong to any group, select
[Nonel].

« If you want to create a new group, enter the new group
name.

The new marker will be
added; it appears as
selected and will be
displayed in the marker
preview.

[Marker Settings

Cancel

Enter the marker name.

Import
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/ Camera and Picture Control

B Editing the Marker

1

Select a marker by placing a check mark and click the selected marker
name.
The marker is displayed in the marker preview.

[Marker Settings

Edit the marker by dragging with the mouse and/or entering the

coordinates of the marker.

* Drag the frame of the marker to move the marker.

* Drag one of the square marks on the frame to change the marker size.

* Taking the upper left corner as the base point, you can enter the coordinates of the marker
as a percentage. Clicking [Apply] after entering the coordinates displays the marker at the
specified coordinates.

» The safety zone, center, level and aspect markers cannot be edited.

B Exporting the Marker

1

Select a marker you wish to save and click [Export].

When a window asking the destination folder and the file name is displayed, specify the
destination folder and the file name.

IMarker Settings

B Importing the Marker

1

2

Click [Import].

When a window asking which marker to be imported, specify a marker that you wish to import.

Enter the information about the marker and click [Add].

» [Marker name] and [Aspect ratio] will be automatically entered according to the file.
* Clicking [Add] imports the marker and displays the newly imported marker in the marker list.

B Deleting the Marker

1
2

Select a marker or a group you wish to delete.

Click [Delete].

« Click [Yes] when a confirmation window is displayed.

* When deleting a group, the group and all the markers in the group will also be deleted.
» The safety zone, center, level and aspect markers cannot be deleted.
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Splitting the Preview Image

You can split the preview image vertically or horizontally and compare the camcorder picture with
other picture. The splitting function helps you to compare the picture color or brightness with other
picture when you want to adjust or change the settings.

1 Rec Viewer (17%)

Click &=1.
; Clicking [[i1]] cancels the splitting.

* You can drag the splitting line on the preview with the mouse to move the splitting line.

Rec Viewer (17%)

* The mouse cursor will change to \@ on the splitting preview image. By clicking on the
preview image and dragging the mouse, you can reposition the displayed image.

Rec Viewer (17%)

B Changing the Split Settings
You can change the splitting settings by clicking [ while splitting the preview.

Rec Viewer (17%)

I
Position of camera preview L3

Reference image p— 2

Refrash reference camera view —I_

1 Selects the position of the camcorder picture to be displayed.
Selecting [Upper] or [Lower] splits the picture horizontally and [Right] or [Left] splits the picture
vertically.
2 Selects the reference picture to be displayed.
[Capture camera view]: Displays a still image captured from the camcorder picture.
[Play viewer]: Displays the picture that appears in the [Play Viewer] ([116-50).
[Still image file]: Displays a selected JPEG image.
3 Refreshes the reference image when [Capture camera view] is selected as a reference image.

Zebra Pattern
You can display a zebra pattern on the preview.

Click [Iz1.

* When the camcorder is set to EXT.CONT.
mode, the zebra pattern will be displayed
also in the camcorder screen.

« Clicking [T_1] cancels the zebra pattern to
be displayed.

1 Rec Viewer (17%)

« Clicking j next to while displaying the zebra pattern on the preview lets you select the
displayed zebra pattern level from the menu.
» The zebra pattern on the preview will not be recorded.
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/ Camera and Picture Control

[Focus Assist]

The [Focus Assist] window displays a part of the camcorder picture as in its original size (100%). You
can check the focus of the picture while the reduced size [Rec Viewer] is being used.

Focus Assist - Aspect correction : 16:9

3 2

Displays a part of the camcorder picture as in its original size. The mouse
cursor will change to ="] on the focus preview image. By clicking on the
preview image and dragging the mouse, you can reposition the displayed
image.

Changes the aspect ratio correction mode. When the correction is ON,
the aspect ratio of the image is adjusted by CONSOLE to fit the aspect
ratio of the monitor. The status of the mode will be displayed on the title
bar.

3 Color/Monochrome Switches over the preview to color and monochrome.

1 Focus Preview

2 Aspect Ratio

[Camera Control]

This window enables you to control the hard disk recording and set the camcorder settings.
1 2

Control

Camera |

Information

| WWHITE BALANCE
| g AWB -

= A>-_
- a . B/
- o Bk

5

i
| IRl

MEAR

EXP LOCK

4 3

Displays the [Information] tab.
Displays the [Control] tab.

When [Sequence] or [Frame] mode is selected in the [Option Settings]
window, you can finalize and save the recording file while recording.

Starts/Stops recording onto the hard disk.

1 [Information]
2 [Control]
3 Finalize

4 Start/Stop Recording
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1 [WHITE BALANCE]
[Control] Tab
You can adjust the white balance by clicking the indicated marks. Placing the mouse cursor on the
2Py When the camcorder is set to the Camera mode, you cannot control all settings on [Control] panel and right clicking the mouse turns the pointer to the right; left clicking the mouse turns the
“Zd tab. Set the camcorder’s recording program to EXT.CONT. pointer to the left. The panel image differs depending on the camcorder you are connecting. The
screen shot below will be displayed when connecting the XH G1 or XH A1.
1 2 3
T Y - 1 |
Camera Control ﬁ "-
AWE)
Contral
YYHITE BALANCE 1
5
1 AWR Auto Automated adjustment of the white balance.
2 / E Preset A/B Adjust the white balance to the preset setting.
2 3 Custom White Balance |While one of the presets is being selected,
clicking on this button registers the white
balance setting.
- For details about saving the white balance
settings, refer to the camcorder instruction
3 manual.
4 Color Temperature Specifies the color temperature. Clicking [ ]
n or [#] in the Kelvin text box increases and
decreases the value by 100K. You can enter a
new value by clicking the Kelvin text box with
the mouse and pressing the [Enter] key on the
keyboard. Click the [Enter] key again to apply
4 the new value.
5 E Kelvin Text Box Sets the Kelvin degree of the Color
Temperature, indoor or outdoor.
6 = Indoor (3200K) Incandescent light. Clicking [ | or [*] in the
=i Kelvin text box increases/decreases the value
— | in 9 levels (1 level: approximately 100K).
Uphon... w0 7 | Outdoor (5600K) Bright sunlight. Clicking [ ] or [¥#] in the
| e Kelvin text box increases/decreases the value
in 9 levels (1 level: approximately 100K).

The Kelvin degree for indoor and outdoor cannot be adjusted when connecting the XL H1 or
XL2.
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2 [IRIS]
You can set an aperture value.

3 [SHUTTER]
You can set the shutter speed.

4 [ZOOMJ/[FOCUS]

You can control the zooming and focusing functions of the camcorder by moving the slider. The
zoom and focus position moves slowly when the slider is close to the center. When you move the
slider further from its center, the camcorder zoom and focus position will move faster. You can also
adjust the zoom and focus position of the camcorder with the [«] and [—] keys on the keyboard
after clicking the slider with mouse.

2y © When you are using a manual video lens and selecting [Manual], you cannot control the
“Z4  zoom function from CONSOLE.
O When the focus switch of the lens is set to AF, or when you are using a manual video
lens, you cannot adjust the focus function from CONSOLE.
5 [Option Settings]
Clicking displays the [Option Settings] window.

Option Settings

7 SE Mode

6 Fratio: e ]
° 2
N 3

Selects a frame rate.

Selects a test tone when displaying the color bars.

Selects a focus speed when operating by keyboard.

Selects a zoom speed when operating by keyboard.

Displays/Hides the color bars.

Selects the aspect ratio when recording in DV.

NOOhARWOINI=

Selects AE mode.

@ The AE mode, aspect ratio and frame rate cannot be changed during the recording.

6 [EXP.LOCK]
Click this button to lock the exposure.
7 [GAIN]

You can adjust the gain level by clicking the scale. Placing the mouse cursor on the panel and right
clicking the mouse turns the pointer to the right; left clicking the mouse turns the pointer to the left.

O The gain level can be set only when the AE mode is set to auto, Tv, Av or manual mode.
@ O When you are using XL2 and set the camcorder’s frame rate to 24F or 30F (NTSC) or
25F (PAL) the camcorder’s gain setting can only go up to +12dB even you set the
CONSOLE'’s gain setting to +18dB.

8 [AE SHIFT]

You can adjust the AE level by clicking the scale. Placing the mouse cursor on the panel and right
clicking the mouse turns the pointer to the right; left clicking the mouse turns the pointer to the left.

@ [AE SHIFT] can be adjusted only when AE mode is set to Auto, Tv or Av mode.
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/ Camera and Picture Control
[Information] Tab 1 |Displays the recording file name, a recording mode, a file type and the video folder specified

in the [Option Settings] window ([113-17).

Displays [Recording history] ([115-48).

Displays the number of data droppings occurred during recording ([115-48).
Camera Control 4 |Plays back the file selected in [Recording history] ([115-48).

This tab shows information of the hard disk recording.

Infarmation

Hemaningtme 1 h32m
Hecording mode  Standard mode
File type & F'El_'i'-._

File narme

CiMsL £
ISHELEIEIEIE MF‘EG

- Dropped data




CONSOLE Windows | Various Settings and [Performance Check] | Camera and Picture Control = Recording onto the Hard Disk = Playback the Recorded Files m

/ Camera and Picture Control

1 [Color Picker]
Waveform Vector Monitor The values of selected pixel in [Rec Viewer] are displayed.

This monitor shows a waveform and color information of the picture displayed in the [Rec Viewer]. ! 2 3 4

1 2 3 1 |Displays/Hides the color picker.
2 |Displays the coordinate of the selected pixel.
3 |Displays the color of the selected pixel.
4 |Displays the numeric color value of the selected pixel.
Vect|r and Wave Monitor

When the color picker is activated, a marker will be displayed on the preview. You can drag the
Display marker to select a pixel.

. ¥ 174 sl 155N =M. Rec Viewer (17%)
R 237G 17 B 54 :
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/ Camera and Picture Control

2 [Line Select]
You can select the image-scanning mode of the waveform monitor and the vector scope.
1 2

1 |Switches over between the line and full scan mode.

2 |Displays the selected line number.

3 |Selects a number of lines used in the line mode.

A line on the preview will be displayed in the line mode. You can drag up/down the line with the
mouse to select a scan line.

Rec Viewer (17%)

A line for
scanning

3 [Display]

You can display and hide the waveform monitor and the vector scope.
4 Waveform monitor

A waveform of the preview picture is displayed.
5 Scale

You can select the scale of the waveform monitor.

[IRE]: -40 IRE - +140 IRE

[Voltage 1]: -0.3V — +1.0V

[Voltage 2]: 0OV - +1.3V

6 [Wave Mode]

You can select the display mode of the waveform monitor. In the PARADE mode, the waveform
monitor will be tri-partitioned.

[Composite]: Displays a luminance and color-difference signal

[Yl: Displays the luminance signal

[YUV]: Displays the luminance signal, the blue differential signal, and the red differential
signal in PARADE mode.

[RGB]: Displays RGB signals in the PARADE mode in the R, G, B order.

7 Vector scope

Displays the color information of [Rec Viewer]. Depending on the recording standards, the panel
changes automatically.
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/ Camera and Picture Control

[Color Control]

The settings for [Color Correction] and skin and sky details are managed on the [Color Control]
window. You can switch over each panel by clicking the tabs.

@ When connecting the XL H1 or XL2, this function will not be activated.

[Color Correction]

B Determining and Adjusting the Color To Be Corrected

The color correction will be set by adjusting the hue, chroma, area and Y level, the corrections will

only be applied to the set color.

« [Color Phase]: Select the basic color phase (0-15) of the color to be detected. Use the following
values as an approximate reference: O=purple, 3=red, 6=orange, 9=green, 12=blue.

* [Chromal]: Adjust the color saturation for the color to be detected. The more you adjust to [+], the
area detected will extend to include more vivid and richer colors.

« [Area]: Adjust the color range for the color to be detected. Adjusting to [+] detects a wider color
range, and to [-] a narrower color range.

« [Y Level]: Adjust the brightness for the color to be detected. Adjusting to [+] detects brighter colors,
and to [-] detects darker colors.

1 T T— @) Click the [Color Correction] tab and
= [EEEl of [A Area Select].
* The [Color Phase], [Chromal], [Area] and [Y Level]
sliders will be activated.
« To set the B area, click of [B Area
Select].

Detail

2

Adjust the levels of [Color Phase],

[Chroma], [Area] and [Y Level] by

moving the sliders.

* For details about each parameter, refer to the
camcorder instruction manual.

» The area that will be corrected will appear as a
white area alternating with the normal image.

Color Control

4o

Detail

Calor P
e

Chrama

Click of [A Area Select] to finish
the setting.

Click of [B Area Select] to finish the B area
settings.

Detail

@ o Clicking the [Detail] tab while configuring the settings ends the setting process leaving
the settings as they are.
O The Custom Preset settings cannot be adjusted while configuring the settings.

B Adjusting the Color Correction

* [R Gain]: Adjust the red gain of the detected area. Adjusting to [+] results in stronger red tones, and
to [-] in stronger cyan tones.

* [B Gain]: Adjust the blue gain of the detected area. Adjusting to [+] results in stronger blue tones,
and to [-] in stronger yellow tones.

Click of [A Area Review].

— = + [R Gain] and [B Gain] sliders will be activated.
ST & - To adjust the B area color, click of [B
= Area Review].

Color Control ﬁ
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Adjust the levels of [R Gain] and [B [Detail]
Gain] by moving the sliders. Skin and sky details settings are managed on the [Detail] window.

For details gbout e?ch parameter, refer to the B Setting the Skin Detail Area
camcorder instruction manual.

Color Control

Detail

Color Control

&| Click the [Detail] tab and [EEEE of
S [Area Select].

The [Hue], [Chromal], [Area] and [Y Level] sliders
will be activated.

Click of [A Area Review] to
finish the setting.

Click of [B Area Review] to finish the B
area settings.

Detail

@ o Clicking the [Detail] tab while configuring the settings ends the setting process leaving 2
the settings as they are.
O The Custom Preset settings cannot be adjusted while configuring the settings.

Color Control

& Adjust the levels of [Hue], [Chroma],
== [Area] and [Y Level] by moving the
sliders.

* For details about each of the terms, refer to the
[Color Correction] ([114-34).

Detail

B Executing the Color Correction

» The area that will be corrected will appear as a
1 CaloFtontrol E Click K3 of [CORRECT] and select an white area alternating with the normal image.
— area in which the color will be
Jetsl
corrected.

The color will not be corrected if [OFF] is selected.
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/ Camera and Picture Control

H Setting the Sky Detail

Click of [Area Select] to finish
— the setting. 1

Color Control

Color Control

&) Click Ed of [Effect] and select [Soft].

==+ CONSOLE automatically detects the sky area
(blue area) and reduces noises.

* The sky detail settings will not be effective if [OFF]
is selected.

Detail

Click Ed of [Effect Level] and select
[High], [Middle] or [Low].

The skin detail settings will not be effective if [OFF]
is selected.

Color Control %]

Detail

@ o Clicking the [Color Correction] tab while configuring the settings ends the setting process
leaving the settings as they are.
O The Custom Preset settings cannot be adjusted while configuring the settings.
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/ Camera and Picture Control

[Custom Preset]

You can adjust, load, save and export the Custom Preset settings. For details, refer to the camcorder
instruction manual.

o Depending on the camcorder connected, some parameters differ. For details, refer to the
@ camcorder instruction manual.
O The [Custom Preset] window cannot be used when recording.
O When using XL2, you need to set the camcorder’s recording program to EXT.CONT.
o When using XL H1, you need to set the camcorder’s recording program to EXT.CONT. to
import and export the Custom Preset file saved on the card.
O After altering the Custom Preset settings, you need to save the new settings. The
new settings will not be saved in the following cases.
- Changing the camcorder mode from EXT. CONT. to other modes or from Camera mode
to other modes
- Disconnecting the IEEE1394 (DV) cable
- Changing the position of the TAPE/CARD switch

2y © You can change the setting using the keyboard.
' - You can select the next item with the [1] or [Tab] key, and go back to the previous item with
the [1] or [Shift] + [Tab] keys. You can also select items by pressing [2] (down), [4] (left), [6]
(right), and [8] (up) keys.
- The parameters can be changed with the [<] and [—] keys.

Adjusting the Custom Preset Settings

o Click B3 of [Memory No.] and choose
a Custom Preset number that you wish

to adjust.

* The selected Custom Preset settings are applied
to the camcorder.

» The Custom Preset settings will not be applied if
[OFF] is selected.

* When the camcorder is connected, the current
settings applied to the camcorder will be displayed
and [Current Setting] will be displayed in the
[Memory No.] box.

B-G Matriz G-B Matrix
B-B Matriz B-F Matriz

G-F M atriz B-G M atrix

Import Export Wariation

2 Enter a Custom Preset name.

To enter a new name, click on the [Preset Name] box with the mouse and press the [Enter]
key. Enter a new name and press the [Enter] key again to apply the new name.

%]

Custom Preset
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/ Camera and Picture Control

7 Adjust each slider to obtain the image Importing the Custom Preset

you want. CONSOLE imports the Custom Preset file in the camcorder or the hard disk and applies to the

Clicking resets the settings to the camcorder.

recently registered settings applied to the memory ) ) ) )

number. @ When importing the custom preset file from the card, you need to have installed the AV/C
Camera Storage Subunit-WIA driver with a camcorder that is set to the EXT.CONT. mode

connected to the computer.

g Click G-

Custom Preset

F Gain
——m—
G Gain
— ———
B Gain
—_— ———
Setup Level Caring
—_— ————
DTL HAY BaL
— ———

HOTL FREQ

[G-F Matrix
— ———

Impart Expart

4 PR EEl to save the new settings.

F-B b atrin B-R M atriz
G- Matrix B-G Matrix

= . = .

5 If new memory is selected before clicking , a window asking you whether or not : S\ —

& you wish to save the new settings will be displayed. Clicking [No] discards the new settings =
and displays the new selected memory number settings.

5 click [Yes] to overwrite the new settings.




[ CONSOLE Windows | Various Settings and [Performance Check] = Camera and Picture Control | Recording onto the Hard Disk = Playback the Recorded Files m

-

Camera and Picture Control

2 Select a Custom Preset file. Exporting the Custom Preset
* When importing a Custom Preset file from the card, select . You can save the current camcorder setting as a Custom Preset file.
- When selecting , you cannot import Custom Preset files that were recorded separately
when recording on a tape. To import such Custom Preset files, first copy them to the hard When exporting the custom preset file from the card, you need to have installed the AV/C
disk and import the file from the hard disk. ([116-52) Camera Storage Subunit-WIA driver with a camcorder that is set to the EXT.CONT. mode
» When importing a Custom Preset file from the hard disk, select . connected to the computer.
- Selecting displays a list of the recently imported and saved files. You can select a file
from the list. Click |- to select a file that is not in the list. 1 — Click ==m.

The information of the selected Custom Preset
setting is displayed, and the settings are applied to
the camcorder only to preview the picture. The
camcorder settings have not been set yet.

Impart — ¢

3  Check the camcorder picture and the settings, and click [OK].

Clicking [Cancel] stops importing the file and returns the camcorder setting to the previous
setting.
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Select a destination to export the file.
The information of the selected Custom Preset setting
is displayed and the settings are applied to the
camcorder only to preview the picture.The camcorder
settings have not been set yet.

* Select the preset number you wish to export when selecting .
* When selecting , specify a file name to be saved.
- Select a file from a list of the recently exported and saved files. If you wish to export a file
that is not in the list, click |.-| and select a file.

Check the camcorder picture and the settings, and click [OK].

Input a preset name, specify the protect mode and click [OK].

* When a confirmation window appears, click [Yes].

» The Custom Preset file will be saved, and the camcorder settings will be returned to the
previously selected Custom Preset file setting.

Camera and Picture Control = Recording onto the Hard Disk = Playback the Recorded Files

Practical Usages of the Custom Preset Files

Use of the Disconnected Camcorder After Adjusting the Custom
Preset Files

This is how to apply the new Custom Preset settings to the camcorder that is disconnected from the
computer, after adjusting the Custom Preset files by the computer.

@ After disconnecting the camcorder from the computer, you will lose the new Custom Preset

2ON -

settings adjusted from the computer if you do not save the file to the camcorder. When the
camcorder’s recording mode is set to Camera mode, the camcorder does not retain the new
settings but returns to the Custom Preset settings active on the camcorder before connecting
to the computer.

Adjust the Custom Preset settings. ((114-37)

Save the new Custom Preset file to the camcorder.

Disconnect the DV cable from the camcorder.

Apply the saved file created in step 2 to the camcorder by operating

the CUSTOM PRESET SELECT and CUSTOM PRESET ON/OFF buttons
on the camcorder.
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Passing Down the Custom Preset Setting to the Other Camcorders

This is how to transfer the Custom Preset file to other camcorders using a card to make clone
camcorders.

Import and save

A the Custom Preset
@ & file from the card
A </ to the camcorder.

Save the Custom Preset
file to the camcorder and
on a card.

The Custom Preset files created by XL2 and XL H1 are mutually compatible and the files
created by XH G1 and XH A1 are mutually compatible as well. However, files created by XL2/
XL H1 are not compatible to XH G1/XH A1 and vice versa.
[Preparations]
Insert the card to the camcorder that is set to the EXT.CONT. mode. Connect the camcorder to the
computer and install the AV/C Camera Storage Subunit-WIA driver ([ 1-7). If you already installed
the driver, you do not need to re-install it.

ZPN For details about the steps 3 to 6, refer to “Inserting/Removing a Memory Card” and “Using the
“Z4l Custom Preset’ on the camcorder instruction manual.

1 Adjust the Custom Preset settings.

2 Export (save) the adjusted Custom Preset file to both the card and the
camcorder. (014-39)

o If you disconnect the cable before exporting the Custom Preset file and change the
@ mode, the camcorder settings will be adjusted to the previous settings.

O When you cannot save on the card, export the Custom Preset file to the hard disk,
change the connected camcorder to the next one, import the exported file to the second
camcorder, and save the file on the camcorder. Installation of the AV/C Camera Storage
Subunit-WIA driver may be needed for the second camcorder.

3 Insert the card with the exported file to the second camcorder.
You need to set the camcorder to the Camera mode.

4 Import the file saved on the card (previously exported) to the
camcorder.

5 savethe imported file on the camcorder.
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6 Apply the saved file to the camcorder by operating the CUSTOM
PRESET SELECT and CUSTOM PRESET ON/OFF buttons on the
camcorder.

If you intend to create multiple clone camcorders, repeat steps 3 to 6.

Creating a New Custom Preset File Using an Existing File as a Base

This is how to create a new Custom Preset file using another Custom Preset file as a base. Follow the
procedure below to create new file without overwriting the existing file.

1 Select the existing Custom Preset number.

2 Export the selected Custom Preset file to the computer’s hard disc.
(D14-39)

3 Select a different Custom Preset number.

4 Import the Custom Preset file (114-38) saved on the hard disc in
step 2.

5 Adjust the Custom Preset file. ((114-37)
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/ f Camera and Picture Control

=

1 [Display Mode] Selects the display mode of the current and candidate images.
Preset Variation [Fit]: Resizes the still image so the whole image will be
h— . — . — . — displayed in a frame.
Clicking on [EzEEEg displays the [Variation] window. The [Variation] window shows still images [Clip]: Displays the still image without adjusting its size. To specify
captured from the camcorder picture with different parameters in order to contrast the current settings which part in the image to be displayed, click (ZEZ, and
with alternative settings. specify an area to be displayed in the [Position Select]
window.
2 [Level] Specifies the variation level. Clicking redisplays the images in the
specified level.
3 [Reference] Specifies the reference image to be displayed.
setting [Original): Applies the same settings as the current image.
1 2 3 4 [Image File]:  Displays a selected still image file.

[Play Viewer]: Displays a captured still image of the displayed picture in
the [Play Viewer] window ([116-50).
4 [Settings] Displays the current Custom Preset setting. Placing the mouse cursor on
| | the candidate image highlights the corresponding setting. You can close
the window by clicking the button again.

Variatio

e — e 5 Candidates Still images with the different Custom Preset settings. Clicking one of the
e il images makes CONSOLE to apply the settings of the selected image to
ST = I | ‘ the camcorder, and refreshes the window.
= 6 [Current] A still image captured with the current Custom Preset settings.
7 [Cancel] Closes the [Variation] window. The setting of the camcorder returns to
original settings.
8 [OK] Closes the [Variation] window.
9 [Reference] A still reference image.
10 Category Tabs of different categories of the Custom Preset settings.
22 O When displaying the [Variation] window for the first time in HD and SD modes, the color bars

will be displayed on the camcorder screen.

O The images used for the candidate are not the same images. Each of the images is
captured separately by the camcorder. When using the [Variation] window, it is
recommended to shoot a still object.

Resetting the Custom Preset
Clicking |

B Gain-(-1] B Gain+ (1]

resets the current settings.
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' Recording onto the Hard Disk

O The time limits for recording to a single file depends on the settings of the camcorder and
CONSOLE. When the recording reaches the time limit recording pauses and then starts
again automatically in a new file. However, there will be some scenes that are not recorded
during the interval when recording stops and then restarts in the new file.

You can record video and audio from a connected camcorder on the hard disk of the computer by
operating the camcorder or the recording panel of CONSOLE.

@ O Before you start recording:
- If you set the video folder to an external hard disk, an error message “Delayed Write

Failed” may be displayed while recording onto the hard disk, and the recording may be Creating WAV Camcorder’s Audio Settings
lost. audio file for

- Make a performance check (11 3-19) to make sure that the recording can be saved to Standard File Type CH3/4 when 2CH ACH
the selected video folder. audio mode is 4

- Make sure that [[[[fJel] is displayed on the camcorder screen. If [[I§2———] or [z ] channels
is displayed, you cannot record on the hard disk. In such case, check the setting of the o 4 hours
video folder ([1] Appx-59). AVI-Type Checked Not Limited 30 minutes

- Whgn magnifying the viewﬂnder image by p.r(.assing the EVF MAGNIFYING button, the DV AVI-Type2 Unchecked Not Limited Not Limited
beginning of the recorded file may be magnified as well. When you are using the frame
recording function, the recorded frame-by-frame image will be magnified when enlarging MXE Checked 3 hours 3 hours
the viewfinder image. Deactivate the magnifying viewfinder before you start the recording. Unchecked 3 hours 3 hours

- We regommend defragmenting the drive on wh_ich the video folder_is located. - VPEGTS Checked Not Limited 3 hours

- Deactivate all programs that access the hard disk on a regular basis (e.g_. as an_tl-wrus Unchecked Not Limited Not Limited
software). Data may be dropped when such programs access the hard disk during HDV
recording Checked 3 hours 3 hours

e I . . MPEG2ES
- If you wish to edit using the time code, make sure to record simultaneously on a tape. The Unchecked 3 hours 3 hours

time code information will only be written to the hard disk when recording on a tape. The

time code will not be written in the cache recording part ([115-46).

O In the following cases, recordings cannot be saved on a hard disk:

- During option settings or performance check.

- When the sequence number of the file exceeds the maximum value (e.g.
“CNSL9999999.avi”).

- When CONSOLE is started while using the camcorder with another software.

O Observe the followings during recording:

- Do not activate any other software. When another software is running, data droppings
may occur. Also, when software that accesses the camcorder (e.g. editing software) is
started, CONSOLE may not operate correctly.

- Do not change the settings in Windows [Display Properties] window.

- Do not lock Windows by pressing the Windows key and [L] key on the keyboard.

- When the computer shuts down or enters stand-by mode due to the running out of the
battery, the recording file may be corrupted and/or may not be played back.

o Depending on the status of the camcorder or computer, a delay in recording start/stop may

occur when you record on both the hard disk and tape.

o When you start recording simultaneously on the tape and the hard disk, the recording on the

hard disk will start approximately one second later.
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s 1 Recording onto the Hard Disk

Recording a Movie File

By Operating the Camcorder

Press the start/stop button on the camcorder.

» Recording starts on both the tape in the camcorder and the hard disk.

» When XL2 is connected to the computer and other IEEE1394 device is also connected at
the same time, the hard disc recording will not be started even if you press the camcorder’s
start/stop button.

* When [Save custom preset file when recording start.] is selected in the [General] tab setting,
the Custom Preset file will be saved in the same folder as the video folder. The name of the
Custom Preset file is the same as the recording file name.

+ [[I%2,®@] appears on the camcorder screen.

* When no tape is inserted, or the tape is write-protected, recording is saved only on the hard
disk.

« Even when the tape reaches the end, recording onto the hard disk continues.

« To stop recording, press the start/stop button on the camcorder again.

By Operating CONSOLE

Click @EEE in the [Camera Control]
window.
To stop recording, click (LIS

Camera Control 5‘

Informat < Contral

AESHIFT | WHITEBALANCE |
2_:1_.-{15 EE B

= L=—"% = -
= = E

|
R

» Recording starts on both the tape in the camcorder and the hard disk.

* When [Save custom preset file when recording start.] is selected in the [General] tab setting,
the Custom Preset file will be saved in the same folder as the video folder. The name of the
Custom Preset file is the same as the recording file name.

- A changes to (LI, and the recording indicator in the [Rec Viewer] window
starts rotating.

* When no tape is inserted, or the tape is write-protected, recording is saved only on the hard
disk.

« Even when the tape reaches the end, recording onto the hard disk continues. When you
restart the recording by pressing the camcorder’s start/stop button after changing the tape,
the camcorder will start to record on the tape, and CONSOLE will keep recording onto the
hard disk.

* When recording in HDV standard on the tape and hard disk, a new file will be created after
changing the tape when you restart the recording by pressing the camcorder’s Start/Stop
button. The computer stops the recording and restarts recording onto the new file.

« To record the next scene as another file in [Sequence] or [Frame] mode, finalize the file by
clicking (EE=2 while recording or when recording is stopped.

o When the frame rate was changed during recording, recording stops, and a new file will be
& created when recording is resumed.
O When using a laptop computer, the recording will not stop even if the display is closed.
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Cache Recording

You can set CONSOLE to store the camcorder picture before recording. When you start recording,
the last 10 seconds previous to the recording start are also recorded in the file. By using the cache
recording, you can reduce the chances of missing the beginning of important scenes.

When you start a simultaneous recording while receiving the HDV standard signal, the cache
recording cannot be performed.

Setting the Cache Time

Select [Option] from the [File] menu

™
i CONSOLE or click .

Viewy)  VersioniT)

Shortcut Settings(S)

Exit(¥)

| Custom Preset

Select [General] tab, and set the
cache time.

* You can select from “0 Sec.” to “10 Sec.”.
+ Selecting “0 Sec.” disables the cache recording
function.

Camera and Picture Control Recording onto the Hard Disk = Playback the Recorded Files m

3 click [OK].

2y © When recording in DV and [Recording mode] is set to [Frame], the cache recording function
&z is disabled.
o When recording in HDV, the cache recording time is actually longer than the time set.
O The cache recording data is cleared in the following cases:
- When the frame rate is changed.
- When the sound recording mode is changed.
- When the recording mode is switched from E)(()LT to one of the other modes or from any
other mode to (g -
- When the recording standard is changed.
- When IEEE1394 (DV) is disconnected or reconnected.

Cache Recording

1 Set the cache time. (1 5-46)

If you close CONSOLE after setting the cache time, the cache recording will begin
automatically the next time you start the software.

2 Startthe recording. ([115-45)
* CONSOLE records the cached picture and the camcorder picture onto the hard disk.
» The cached picture will not be recorded on the tape.
* When the recording is stopped, CONSOLE starts the cache recording again.
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' Recording onto the Hard Disk

Frame Recording

You can record frame by frame in the same file. This function enables you to easily create a stop
motion animation movie.

@ O When recording in HDV or setting the frame rate to 24F, the frame recording function cannot
be used.

o [[[¥2,——] will be displayed in the camcorder screen; however, the frame recording
cannot be controlled from the camcorder.

Setting the Frame Recording

1 Select [Option] from the [File] menu
i CONSOLE or click % .

Viewy)  VersioniT)

Lu]
il

Shortcut Settings(S)

7]

Exit(¥)

Custom Preset

Option Settings

Select [DV Rec] tab and select
[Frame] as the recording mode.

When [Interval recording] is checked, CONSOLE
repeatedly records the frame image at the
specified interval time.

3 Click [OK].

1
2

Frame Recording

Specify the frame recording settings. ([115-47)

Camera Control g‘ Click _ in the [Camera
: = = Control] window.

MEAR

EXPLOCK |
. Optich...

* CONSOLE records onto the hard disk only. You cannot record on the tape when you are
recording frame by frame.

» When [Interval recording] is selected in the [Option Settings] window, (Sl changes to
B . and clicking [T pauses the recording.

* When [Interval recording] is selected, the remaining time will be displayed in [Rec Viewer].

« If you want to record the next scene to a different file, click (lE-—all to finalize the file.

» While I is appearing, clicking (=2l stops the interval recording. To restart the
interval recording, click (S -
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Recording onto the Hard Disk

Data Dropping

« If the hard disk is accessed while recording, a part of the data input from the camcorder may not be
written to the file (data dropping). This may happen also when the processing capacity of the
computer is insufficient.

When the data dropping occurs, the number of data droppings occurred in a file will be displayed in

the [Information] tab of the [Camera Control] window. When recording in DV, a number of dropped

frames and when recording in HDV, a number of dropped blocks are displayed. Dropping one block
in HDV recording corresponds to dropping from a few frames to up to 20 frames in DV recording.

When the data dropping occurs, [[If§es®] changes to [[[fz2s0] for a few seconds.

When the file is created on the hard disk after recording, you can check the scenes where data

dropping occurred under [Recording history].

If the [CPU usage] displayed in the [Performance Check] window (11 3-19) shows 100%, change

the software settings using one or more of followings to reduce the rate. (90% or less is

recommended.)

- When recording in HDV standard, select [File] » [Option] and click on the [HDV Rec] tab. Select a
smaller size in [Preview resolution] and/or select [I picture and P picture] or [I picture only] in
[Preview picture].

- Hide or reduce the window size of the [Rec Viewer] window.

- Hide or reduce the window size of the [Vector and Wave Monitor] window.

CONSOLE Windows | Various Settings and [Performance Check] = Camera and Picture Control = Recording onto the Hard Disk = Playback the Recorded Files m

Recording History

When you stop recording the picture in [Standard] mode, or when a file is created after finalizing in
[Sequence] or [Frame] mode, the created file information will be displayed under [Recording history]
in the [Camera Control] window.

The recording history will disappear when you close CONSOLE. When you wish to review the

@ history after you have closed CONSOLE, open the “CONSOLE.LOG” file in the video folder
with a text editor. You can check the file name, recording date, file size, length, file type, and
the information about dropped data.

Dropped data

Shows the file name recorded with CONSOLE. The file information appears
when you leave the mouse pointer on the file name for a moment.

If data dropping occurred, the position and number of dropped data are
shown here.

When a file name is selected: Clicking (& starts the playback panel and
the file is played back from the beginning.

When information on dropped data is selected: Clicking [E& plays back the
file in the [Play Viewer] window from the point where the data dropping
occurred.

1 File name

2 Information on
dropped data

3 Playback
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You can playback or view the recorded pictures using playback tools in [Play Panel].

Playback the Recorded Files

[Play Viewer]
You can playback and preview the recorded files.

2 When the preview image is not smoothly played back, the playing back condition of the image
' may be improved by hiding the [Rec Panel] or [Rec Viewer], not displaying the camcorder
picture.

1

Play Viewer {17%)

10

Playback Preview

Audio Monitor
Settings
Audio Monitor

Audio Level
Indicator

Time Slider

Special Playback
Modes

Output
=/ e

Time Code
File Name

CONSOLE Windows | Various Settings and [Performance Check] =~ Camera and Picture Control Recording onto the Hard Disk = Playback the Recorded Files m

Displays the played back pictures selected in the [File Browser] window
([I16-52). Right clicking on the preview window allows you to select the
size of the preview panel ([114-23) and to display the overlay markers
(004-24).

Selects which audio channel to be displayed on the audio level indicator
and adjusts the monitor volume.

Turns ON/OFF the computer’s audio monitor output.

Displays the audio level of the playback file. The sound can be monitored
with the computer’s sound system.

Allows you to change the playback position. ([116-51)

Specifies the playback speed (Special Playback Modes). There is no
sound during special playback. The special playback modes can be
applied to fast-forwarding only.

DV/HDV: 1/3, 1/2.5, 1/2, 1x, 2x, 4x

Displays the playback images on the camcorder screen. ([116-51)

Plays/Pauses the playback file. When you pause the file, click & to
restart the playback.

Shows the playback position of the file.
Displays the playback file name.

You cannot monitor the sound on channel 3 and 4 when playing back a MPEG2ES recorded in

HDV.
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Output to the Camcorder

By connecting the camcorder to the monitor, you can output the recorded pictures from the computer
to the monitor.

—_— ——
—

]

O To output the playback pictures to the camcorder, you need to set the camcorder’s
@ recording program to EXT.CONT.

O When using XL H1:

If you select the HD mode, only video in HDV standard video is displayed on the monitor; if
you select the SD mode, only video in DV standard video is displayed on the monitor.
When using XL2:

Only video in DV standard is displayed on the monitor.

O When the camcorder is set to HD mode and the [HD DOWN-CONV] menu under [SIGNAL
SETUP] in the [VCR/PLAY] menu is set to [ON], the playback picture will not be output to
the camcorder.

O When [HD DOWN-CONV] is set to [ON] and you are unable to output the playback picture
to the camcorder, do not change the POWER dial from EXT.CONT. to any of the recording
programs. To do so, causes the error message “Another application is accessing the
camcorder.” to be displayed in the software status ([112-13). In this case, disconnect and
reconnect the DV cable.

O The camcorder’s SDI terminal cannot be used for outputting pictures from CONSOLE.

O When setting the camcorder to EXT.CONT. the following limitations apply to CONSOLE.

- Unable to use the special playback modes.

- The sound cannot be monitored with the computer’s sound system.
- When pausing the playback, no image is displayed on the monitor.
- Unable to playback MPEG2ES picture.

- Unable to record pictures.

1 Click § in the [Play Viewer] window.
* CONSOLE changes its mode to the output mode, and the camcorder will be set to the
receiving mode.
» While the camcorder is set to the receiving mode, recording cannot be performed.

2 Select a file in [File Browser] (1 6-52).

3 click (Bl or double-click the selected file in [File Browser].
* The playback file is displayed in [Play Viewer] and the camcorder.
« Clicking (il pauses the playback. Clicking [ restarts the playback.
* A few frames will not be displayed when you pause and restart the HDV standard file.
* Clicking |g returns the camcorder mode to the recording mode.

Camera and Picture Control = Recording onto the Hard Disk = Playback the Recorded Files m

Time Slider
* You can change the playback position by dragging the slider with the mouse.
1 2 3 4

LI oo:00:01 FHILILELRS LILELILE LS oo:00:04

Slider

The slider returns to the starting point.

The slider moves to the data dropping point after the current position.
Change the time slider scale.

A WODN =

» Data droppings that occurred during recording are indicated in red.
- By clicking (@, the slider moves to the next data dropping point after the current position. By
clicking G, the slider moves to the previous data dropping point before the current position.

4= = I"til.

oo:00:44 Q00045 Q00086 oo:00:47 O0:00:45

O While pausing the playback picture, pressing the [«] or [] key on the keyboard after

' moving the slider with the mouse allows you to finely adjust the position of the slider.

- When adjusting the position of the playback picture of an HDV recording with the [«] or
[—] key, you cannot adjust the picture frame by frame.
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Waveform Vector Monitor

A waveform of the playback picture and the color information are displayed. The functions are the
same as the waveform vector monitor ([114-32) of [Rec Panel].

File Browser

In the file browser, the files stored in the hard disk are displayed.

File Browser

E op

1 Selects the display pattern. You can select to display only the thumbnails or the thumbnails
with the file information.

2 Selects the display order of the files.

3 Copies from the memory card ([116-52).

4 Refreshes the files displayed in the window.

5 Displays the files in the selected folder.
Double-clicking a file, the selected file will be played back in [Play Viewer].

6 Displays the explorer view.

2y ° Placing the cursor over a file for a few seconds will display the file information.
"“Z4 o Files recorded in 24F mode are marked with (NTSC only).
O To delete a file, right-click the thumbnail and select [Delete] from the displayed menu.
B8 will be attached to the thumbnails of all Custom Preset files. By right clicking on the
thumbnail, you can check the settings of the Custom Preset and can load the Custom
Preset file to the camcorder.

Copying from the Memory Card
You can copy the still image and the Custom Preset files from the memory card to the hard disk.

O If the total number of files recorded on the memory card is more than 1500 (XL H1) or 2000
@ (XH G1/XH A1), the file browser cannot display the files correctly. In this case, please copy

the files to the hard disk using a card reader/writer, and then check the files in the file
browser.

o When using XL2, you cannot use a memory card.

O You need to set the camcorder’s recording program to EXT.CONT.

O Proper operation cannot be guaranteed if you are not using Canon camcorders to create the
image files.

Click [[B).

The thumbnails of still image files and the
Custom Preset files are displayed.

File Browser

2 St Select a file you wish to copy.

is attached to the thumbnails of the still image files that have the corresponding Custom
Preset files that were recorded in the separate file at the same time when the images were
recorded.
- When selecting a still image with [EF
copied.
* By clicking [Select All] selects all files in the card.
* By clicking [Show custom preset files only.] displays the Custom Preset files only.

, the still image and its Custom Preset file also are

3 Click [OK].

4 select a folder for storing the copied file and click [OK].

To cancel the copying, click [Cancel].
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Uninstall

Uninstalling the Software

Uninstall the software if it has not been installed correctly, or if it is not required anymore.

Uninstalling the AV/C Camera Storage Subunit-WIA Driver

Uninstall the AV/C Camera Storage Subunit-WIA driver if it has not been installed correctly or if it is

not required anymore.
@ O Close any programs that are running, and disconnect the IEEE1394 (DV) cable from the

camcorder and the computer before uninstalling the software. @

O Close all programs that are running before uninstalling the driver.
O You need to log in as an administrator before uninstalling the software

O You need to log in as an administrator before uninstalling the driver.

1 From the [start] menu, select [All Programs] followed by [Canon 1

Turn the camcorder power on and set the camcorder’s recording
Utilities], [CONSOLE 1.1] and [CONSOLE Uninstall].

program to EXT.CONT.

2 Connect the camcorder to the computer using the IEEE1394 (DV)
cable. (011-8)

If Scanner and Camera Wizard or Explorer is displayed, close the windows.

nt
<l
] E-ma
Outlook Express

“MSN B ¥

[ P : 3 Fromthe [start] menu, select [Control Panel].

.3 windows Messenger|| & Inernet Explorer

@ e v 4 @) Click [Printers and Other
- i ortes Tools  Hel

Hardware].

¥ 8w

? Addor Remove Programs Date,Time, Language, an

1(2)) Sounds,Speceh, and Audo Devices

On the confirmation dialog, click
[OK].

Accessibilty Options

@Y Performance and Maintenance |/ Security Center

InstallShield Wizard

On the confirmation dialog, click

InstallS hield Wizard Complete
d

Uninstallation has completed.

[Finish].

C O B P s |

2 Prvers n —

Pick a task...
[3) View installed printers or fax printers

(3] Add aprinter

or pick a Control Panel icon

Click [Scanners and Cameras].

If you cannot find the [Scanners and
Cameras] icon, see Uninstalling of the
Drivers (11 7-55).



Uninstall

Right-click the [Canon Camera
Storage Device] icon and select
[Delete].

When the icon does not appear, see
Uninstalling of the Drivers ([11 7-55).

Uninstalling of the Drivers
If you had problems uninstalling the driver, use the following procedures to remove it.

2y ° Use the procedures below for the following circumstances too.
' - If you do not find the [Scanners and Cameras] icon in the [Printers and Other Hardware].
- If the Camera icon does not appear in the [Scanners and Cameras] folder.

1 From the [start] menu, select [Control Panel].

In the confirmation dialog, click [Yes].

* [#(number)] may appear after [Canon Camera Storage Device], but that would not affect the
uninstall process.

» The uninstall process is complete.

Click [Performance and
Maintenance].

Favortes Tools telp

F Osewen [ roes | [

Click [System].

o

E
Ok O 3| Psst roces |-

ard diskc to make programs run faster.

or pick a Control Panel icon

B scnctuearasts

4 Click the [Hardware] tab on the [System Properties].



Uninstall

Click the [Device Manager] button.

System Restore Automatic Updates Remote
General Computer Name || Hadware Advanced

Device Manager

=&=0  The Device Manager lists all the hardware devices installed
% oh your computer, Use the Device Manager to change the
properties of any device.

[ Devioe Manager |
Diivers

@ Driver Signing lets you make sure that installed drivers are
§ compatible with Windaows. Windows Update lets you st up
how Windows connects to Windows Update for drivers.

[ Driver Signing ] l ‘windows LUpdate

Harduware Profiles

Hardware profiles provide & way for you ta set up and store
different hardware configurations.

Hardware Frofiles

If [Canon Camera Storage Device] appears under the [Imaging
devices] and/or [Other devices] categories, use the following

procedures to delete it.

1) Right click on [Canon Camera Storage Device] and select [Uninstall] from the menu.

5 Device Manager
Fie acion Vew Hep

HES 2 A =<R8

EEX

o 5 Poncta sdaprers
R processors
sound,

Uninstalls the chiver for the selected device

2) In the confirmation dialog, click [OK] and close [System Properties] and [Device
Manager]. Remove all copies of the [Canon Camera Storage Device] icon that appear in
the [Other devices] or [Imaging devices] categories, or that appear more than once in

one category.

Confirm Device Removal

éij Canon Camera Storage Device

‘warking: You are about to uninstall this device from your system.

7 From the [start] menu, select [My Computer] and double-click the [C:]

(local disk), [WINDOWS] and [INF] folders in succession.

> S ook [ oo [ ] v

« If the [INF] folder is not visible in the [WINDOWS] folder, use the following procedures to

show all files and folders.

1) Click the [Tools] menu and select [Folder Options].

2) Click the [View] tab.

3) In the [Advanced settings] section, set the [Hidden files and folders] category to the

[Show hidden files and folders] option.

Map Metwork Crive. .,
Disconneck MNebwark Drive. ..
Synchronize, .,

Cions. ..

Folder Options E]

General | Yiew | File Types || Difine Files

Folder views
“You can apply the wiew (such as Detaiks or Tiles] that
you =re using for this folder to all folders

[ fppb to &) Folders | [ Resst All Folders

Advanced seftings:
] Display the contents of spstem folders -~
Display the full path in the address bar
[ Display the full pathin the tile bar
[] Do ot cache thumbnails
() Hidden files and folders

© Da nat show hidden fles and folders

® s and folders
Hide extensions for known fil types
Hide protected operating system files (Recommended)
[ Launch folder windaws in a separate process
Fiemember sach foldsi's view seltings

[] Fiestore previous folder windows at logon v
Flestore Defaulis
[ ok ][ caneal [ speb |

« If [Hide extensions for known file types] is selected, remove its check mark.



Uninstall

8 Double-click the [oem*.INF] file.

* A number such as “0” or “1” appears in place of the asterisk (*) above. You will also find
another file called [oem*.PNF], which will have the same number as the [oem*.INF] file. The
two constitute one set. There may be many file sets starting with “oem”.

Fle Edt Vew Favortes Tods Heb L
Qe - © (| Oseach [ Foiders | [F]-
s [© CwbOwSIE >
Name See Type Date Modfied ]
File and Folder Tasks (&)l [Somme.pre 10516 Precompied St 3212005525 P
A Soen? 26 Satp rfomation 812004 75557
L Bloenrore 7K0 Preconpled Setup... S/2I20050:27 it
(y Move this il Toems 4KB SetvpInfomation  /11/2004 7:55 P
D) copythstie Bomarme S0 Proconpled Setup... 312120059127 it
@) PublishthisF tothe Vieb Boems 126K8 Setup Information  1/26{2005 3:41 AM
8 emaitiatie Bomane 18K reccapledSetup .. 3202008 801 i
o 20 Satp Ifomation 41202008 L4370
50 Proconpled SeupL... S/IS(2005 34370
2 SLEEIELS 12X Setup nfomation 7/120055105 At
12K Precompled Setup ... 9/15/2005 3:43 PM
Other Places 7KB  Setup Information 8/4/2004 5:00 AM
(8 oobe.Pr 17K Precomplled Setup ... 1/2/2005 11:45 AM
& wmoows optional KB SetupIormatin /412004 5:00 A
@ v vocuments [Sloptonalene 22KB Precompled Setup... 9/2/20058:23PH
= ovcam 156 Setpfomation 54200451000
& oveam.PHF 25KB Precompied Setup1... 1/2/2005 11:45 AM
§ b Conpuec Sovcomp 2B SetupInformation 8/4/20045:00 A
8ty Network laces [Sloveomp.pre 6KB Precompled Seup ... 1/2/2005 11145 A
Sovsond 60 Setplrfomaton SIS0
% | Dovsonsrne 15K Procanpied Setup .. 1122005 11145 A0
Detali N ez 7KB Setup Information  8/4/2004 5100 A
Bezorne 14K Precampied Seup .. 924200552951
Tpunse 140 Setup normation 8472004 5100 0
[Slparhmse.pre 35KB_Precompled Setupl... _1/2/2005 1145 AM )

have found the correct file, delete the file

The Windows Notepad program will start and show the file contents.

When uninstalling the AV/C Camera Storage Subunit-WIA Driver, click each [oem*] file until
you find the one that contains [; AV/C Camera Storage WIA driver] in its first line. When you

set.

7 AV/C Camera Storage WIA driver
Copyright (c) 2008 Canon Inc.

This section is mandatory for all INF Files

Tversion]

[sour cevisksnames . x86]
1=XINST_DISKE, ,,

[Saur cevisksFiles]
Fomind. d11=
< |

accskmd. sys=:
FCExtend, d11=1
i 1

Signature="§CHICAGOS "
C1as5-Image ; Indicates the setup class
C1355GUTD={ 61 F6-810F-11d0-bec7-08002be2092F} } GUID of the setup class
Provi der=xCanon Name OF the INF file provide
catalogrile=Canoncs, cat } Name of the catalog file
brfverver-07,/06,2005,1.4 i oriver versian
[controlrlags]
Excluderromselact=x 3 a1 prp devices should be excluded from manual Addbevice app
[Manufacturer]

anank=Canon ; The manufacturer of Cs target is Canon

1) Close the Notepad window.

2) Right-click the mouse button and select [Delete].

Fie Edt Vew Favorkes Tods Help

Qi © (3| Pswer [ rois |-

adiress [ £ CwINDOWSIInf

are St Type
File and Folder Tasks AL (8 oeme 0 106K8 Precompled Setup ...
o Foen7 2K Setup Iformation
[S]oem e 78 Precompied Setup L.
Y Copy the sslectsd Rers Thoems 448 Setup Information
@ pubishthe soecteditens M S cams.frF aKe Preconpled Setup1...
e ot Thoems 126K Setup Iformaton
Q) Emalthesodions M G0, 17816 Preconpied et .
X oetatheseecredtens M B oemso 248 etup fornaton
(&oem10.pive 8K8  Precompiled Setup I
. 1248 Setup Iformation

Other Places A 1268 Precompled setup 1.

L Open with...
J—— = L 7K8 Setup Information
: Slobestt | smdto b 1716 mecomledsetol.
D yDoument & 516 setu bomatin
D Sheedoscunens Slenterms < 216 meconpled Sop1..
@ My Computer ovcam, Copy ISKE Setup Information

B
2K Setup Information
68 Precompled setup 1.
K6 Setup Information
13K6 Precompled Setup 1.
7K8 Setup Information
1416 Precompied Setup 1.
14K8 Setup Information
parhise. PN 35K8 Precompled Setup 1.

Properties

v B
Date Madfied &
9/2/2005 8:25 P11
8/11/2004 7:55 Pi0
9212005 8:27 P11
8/11/2004 7:55 Pt
94212005 8:27 PM
1§26(2005 3:41 A0
9/2/2005 8:31 P11
4/28/2004 1:43 PH0
9/15/2005 3:43 P11
7512005 9:05 At
9/15/2005 3:43 PH1
8/4/2004 5:00 At
1f212005 11:45 A1
8/4/2004 5:00 Al
9/2/2005 8:23 P11
8/4/2004 5:00 A1
1f2/2005 11:45 A1
8/4/2004 5:00 Al
1212005 11:45 A1
8/4/2004 5:00 Al
1122005 11:45 A
8/4/2004 5:00 At
92/2005 8:23 P11
8/4/2004 5:00 Al

112j2005 145449

9 Close all windows and restart the computer.

The [INF] folder contains numerous files that are critical to the computer’s operation. Be
extremely careful not to delete the wrong files. If you delete the wrong file, you may be
unable to restart Windows.
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Appendix

Troubleshooting

Cannot launch CONSOLE.
=[Hardware acceleration] of your computer is not set to [Full].
1) Open the [Control Panel] window and display the [Display Properties] window by clicking
the [Appearance and Themes] icon followed by the [Display] icon.
2) Click the [Settings] tab and the [Advanced] button.
3) Click the [Troubleshoot] tab and adjust the [Hardware acceleration] slider to [Full]. Then
click [OK].
= CONSOLE may not be launched if movie playback software or video editing software is already
running. You need to close the software and try to launch CONSOLE.

Even though the dedicated driver (Canon Virtual VCR or AV/C Tape Recorder/Player) is
installed already, the [Found New Hardware Wizard] window appears when starting
CONSOLE.
= When you change the computer’s IEEE1394 (DV) card and start CONSOLE, Canon Virtual

VCR or AV/C Tape Recorder/Player will be detected as new hardware. Select [Install the
software automatically (Recommended)] and click [Next] to install the driver.

Cannot select a video folder.
2 Only folders on a NTFS formatted hard disks can be selected as a video folder. You cannot
select a folder on FAT32 or FAT16 hard disks.
= Removable disks or network drives cannot be selected as a video folder.

Camcorder will not be recognized or controlled.

= A camcorder not supported by CONSOLE is connected. Check if your camcorder is supported
by CONSOLE (11 3).

= The DV CONTROL function of the camcorder is set to [OFF]. Set the DV CONTROL function to
[ON]. For details, refer to the instruction manual of your camcorder.

= More than one camcorder is connected to the computer’s IEEE1394 (DV) terminal. Connect
only one camcorder to the computer’s IEEE1394 (DV) terminal.

= If your computer has an IEEE1394 (DV) board/card in addition to the standard IEEE1394 (DV)
board/card, or if you have more than 2 IEEE1394 (DV) boards/cards added to the computer, the
computer may not recognize the camcorder properly. You need to plug the IEEE1394 (DV)
cable to a different board’s/card’s terminal.
To check if the cable is properly connected, follow the instructions below.
1) Set the camcorder to EXT.CONT. and connect to the computer.

2) Open the [Device Manager] window. ([117-56)
3) Select [Devices by connection] from the [View] menu.
4) Look for the IEEE1394 controller with [Canon Virtual VCR].
5) Confirm that [AV/C Tape Device] or [Canon DV Camcorder] is connected.
ﬁ Device Manager E]@
File Action Yiew Help
g 2 a
= &) consoLe ~
= W ACPI Uniprocessar PC
= -g Microsoft ACPI-Compliant System
8 InteliR) Pentiom(R) 4 processor
W Motherboard resources
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Recording will not start even when pressing the start/stop button on the camcorder.

= The start/stop button on the camcorder is locked. Unlock the button.

= When using XH G1, XH A1 or XL H1: If you connect 4 or more devices by IEEE1394 (including
the connected computer and the camcorder itself) or if 2 or more other video devices are
connected to the computer by IEEE1394, recording onto the hard disk cannot be started.

= When using XL2: If the XL2 and 1 or more other devices are connected to the computer by
IEEE1394, recording onto the hard disk cannot be started by pressing the camcorder’s start/
stop button.

[[%22,—-] appears on the camcorder screen and recordings cannot be made.

= Available hard disk space on the drive where the video folder is saved is less than 0.5 GB.
Change the drive or delete some files to free more disk space.

= The [Option Settings] window is open, or performance check is being carried out. Close the
window.

= The sequence number of the file exceeds the maximum value (e.g. “DVPC9999999.avi").
Change the video folder or the file name.

= The camcorder is in use with another software. Close the software.

= The camcorder does not recognize CONSOLE. Close CONSOLE and restart it.

Recording on the hard disk stops in the middle of the recording.
= The hard disk capacity is insufficient. Delete files to make space available, or select a video
folder on a hard disk with sufficient capacity.
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The recorded picture is lacking.

= The recording speed of the hard disk is insufficient. Make a performance check ([113-19). We
recommend defragmenting the drive before you start recording.

= A program other than CONSOLE is started. Close all programs other than CONSOLE before
recording. If an anti-virus software is activated, deactivate it.

= Due to the computer’s processing capacity being lowered, the CPU usage may reach to its
maximum limit. If the usage continuously goes over the 100% for a long time, data dropping
may occur on the recording file. In such case, change the software settings using one or more
of the followings to reduce the usage, and perform [Performance Check] ([113-19) to confirm
the rate. (90% or less is recommended.)

» When recording in HDV standard, select [File] » [Option], and click on the [HDV Rec] tab.
Select a smaller size in [Preview resolution], and/or select [l picture and P picture] or [l picture
only] in [Preview picture].

* Hide or reduce the window size of the [Rec Viewer] window.

* Hide or reduce the window size of the [Vector and Wave Monitor] window.

The preview image is not played back smoothly.
= Depending on the laptop PC’s power scheme settings that control the CPU operations, the
preview image may not be played back smoothly. Follow the procedure below to change the
power scheme settings.
1) Open [Control Panel] and click [Performance and Maintenance].
2) Click [Power Options] and the [Power Options Properties] window will be displayed.
3) Select the [Power Schemes] tab and select [Always On] in [Power schemes].
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Shortcut Keys (Default Settings)

The shortcut key settings written in red can be changed ([I13-21), but the keys written in black cannot

be changed.

B [Option Settings]
Switching the setting item
Next: [Tab]
Previous: [Shift] + [Tab]
Tab Selection: [«<], [~]
To execute: [Space], [Enter]
To change a numeric value
One value up: [T]
One value down: [!]
To select a value in a list
One value up: [T], [<]
One value down: [{], [—]
To select a radio button
To select one above: [1], [<]
To select one below: [1], [—]
To check the selected radio button:
[Space], [Enter]

B Displaying [Rec Panel]: [7], [Ctrl]] + [R]
Changing the tools in [Rec Panel]: [+]

B Displaying [Play Panel]: [9], [Ctr] + [P]
Changing the tools in [Play Panel]: [+]

B [Rec Viewer]
Displaying/Hiding: [Ctrl] + [M]
To select a button
Next: [Tab]
Previous: [Shift] + [Tab]
Up: [T]
Down: [{]
Right: [—]
Left: [«]
To execute: [Space], [Enter]

B [Focus Assist]
Displaying/Hiding: [Ctrl] + [F]
To select a button
Next: [Tab]
Previous: [Shift] + [Tab]
Right: [—]
Left: [«]
To execute: [Space], [Enter]

H [Camera Control]

Displaying/Hiding: [Ctrl] + [S]
Start/Stop recording: [0]

Finalize: [.]

Displaying the [Control] tab: [*]
Displaying the [Information] tab: [/]
Switching the setting item

Next: [1], [Tab]

Previous: [1], [Shift] + [Tab]

Up: [8]

Down: [2]

Right: [6]

Left: [4]

Tab Selection: [4], [6], [<], [-]
Setting the level: [<], []
Zooming: [«], []

Focusing: [+], []
To execute: [Space], [Enter]

B [Option Settings] in the [Camera

Control] window

Switching the setting item
Next: [Tab]
Previous: [Shift] + [Tab]
To execute: [Space], [Enter]
To change a numeric value
One value up: [1]
One value down: [{]
To select a value in a list
One value up: [1], [<]
One value down: [!], [-]

B Waveform Vector Monitor

Displaying/Hiding (in [Rec Panel]): [Ctrl] + [H]
Displaying/Hiding (in [Play Panel]): [Ctrl] + [W]
Switching the setting item
Next: [Tab]
Previous: [Shift] + [Tab]
To switch a button in [Display]: [+], [-]
(These keys can be used only when the
buttons are selected.)
To execute: [Space], [Enter]

To select a value in a list
One value up: [1], [<]
One value down: [!], [-]

To change a numeric value
One value up: [1], [«]
One value down: [{], [~]

B [Custom Preset]
Displaying/Hiding: [Ctrl] + [I]
Switching the setting item

Next: [{], [Tab]
Previous: [1], [Shift] + [Tab]
Up: [8]
Down: [2]
Right: [6]
Left: [4]
Moving the slider
Increase: [—]
Decrease: [«]
Changing items in the pull down menu
Up: [1]
Down: [{]

B Preset Variation

Switching the setting item
Next: [Tab]
Previous: [Shift] + [Tab]
Tab Selection: [«], [~]
To execute: [Space], [Enter]
To change a numeric value
One value up: [T]
One value down: [1]
To select a radio button
To select one above: [1], [<]
To select one below: [{], [—]

H [Color Control]
Displaying/Hiding: [Ctrl] + [O]
Displaying the [Color Correction] tab: [/]
Displaying the [Detail] tab: [*]
Switching the setting item

Next: [{], [Tab]

Previous: [1], [Shift] + [Tab]
Up: [8]

Down: [2]

Right: [6]

Left: [4]

Tab Selection: [4], [6], [«], []

To move a slider
Toward [+]: [—]
Toward [-]: [«]
To execute: [Space], [Enter]
To select a value in a list
One value up: [«<]
One value down: [—]

H [Play Viewer]
Displaying/Hiding: [Ctrl] + [D]
Start/Stop Playback: [0]
Switching the setting item
Next: [Tab]
Previous: [Shift] + [Tab]
To execute: [Space], [Enter]
Time Slider (These keys can be used only
when the time slider is active.)
To move the slider to the left: [«]
To move the slider to the right: [—]
To change a scale: [1], [{]

H File Browser
Displaying/Hiding: [Ctrl] + [E]
Switching the setting item

Next: [Tab]
Previous: [Shift] + [Tab]
To select a button
Next: [{], [-]
Previous: [1], [«]
To select a folder in the folder tree
Up: [1]
Down: [{]
To open a folder: [—]
To close a folder: [«]
To select a file among thumbnails
Up: [1]
Down: [{]
Right: [—]
Left: [«]
To playback a selected file: [Enter]

B Full Screen: [F12]
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